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3DFEM4 – Curved Steel I Beam Using BrDR LRFD Engine 

This example details the data input of a curved composite steel plate girder structure in BrDR and performing a 3D 

FEM analysis.  This example is an I-Girder Bridge, SR 302, from the Mississippi DOT inventory.  

 

 

 

Structure Typical Section 
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Structure Framing Plan 

 

Topics Covered 

• Comments and assumptions 

• Data entry of a four-span curved steel plate girder bridge 

• Diaphragm definitions 

• 3D analysis settings 

• 3D model 

• Analysis and results 

 

Comments and assumptions 

• Per the design plans, the following material strengths were used: 

o Structural steel yield strength = 50 ksi (girders, stiffeners and splices) 

o Structural steel yield strength = 36 ksi (diaphragms) 

o Concrete compressive strength = 4.0 ksi (Class AA) 

o Reinforcing steel yield strength = 60 ksi 

• District, County and Owner information is not populated 

• Traffic data and design speed for LRFR analysis 

o Assumed ADTT = 1000 

o Design speed = 50 mph 

• ¼” Integral Wearing Surface  

• HL93 will be vehicle used for LRFR ratings and HS-20 scaled to HS-25 will be vehicle used for LFR ratings. 

• An additional self-load of 0.01 kip/ft was applied to each beam/girder to account for bolts, stiffeners, 

diaphragm connections, etc. 
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• BrDR 7.5.0 does not handle staggered bolt patterns for girder splices. Bolt patterns are entered as non-

staggered. 

• Splice gap = 3/8” at field splices. 

• Approximate values of “Y” Distance were input for all Diaphragm Definitions. 

Data entry of a four-span curved steel plate girder bridge 

From the Bridge Explorer, create a new bridge using the New button from the BRIDGE ribbon. 

 

Enter the following bridge description data. 

 

Click OK to apply the data and create the new bridge. 
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Bridge Materials – Concrete 

Navigate to the Components tab in the Bridge Workspace tree. Expand the Materials folder. The partially 

expanded Bridge Workspace tree is shown below. 

 

 

To add a concrete material for the deck, click on the Concrete node in the BWS tree and select New from the 

WORKSPACE ribbon (or double click on Concrete or right click and select New).  
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The window shown below opens. 

 

Enter data in the fields above the Compute button and click the Compute button to calculate the remaining 

properties. See image below. 

  

Click OK to save the concrete material and close the window. 
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Bridge Materials – Structutral Steel 

To add a structural steel material for the girder, click on Structural Steel in the BWS tree and select New from the 

WORKSPACE ribbon (or double click on Structural Steel or right click and select New). The window shown 

below opens. Enter the details shown below. 

 

Click OK to save the steel material and close the window. 

 

Similarly, add another structural steel material for stiffeners and diaphragms, using 36ksi strength as shown below. 

 

Click OK to save the steel material and close the window. 
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Bridge Materials – Reinforcing Steel 

To add a reinforcing steel material for the girder, click on Reinforcing Steel in the BWS tree and select New from 

the WORKSPACE ribbon (or double click on Reinforcing Steel or right click and select New). The window 

shown below opens. Click on the Copy from library… button to open the Library Data: Materials – Reinforcing 

Steel window. 

 

 

Select Grade 60 from the window shown below and click OK to close this window and populate the selected steel 

material in the Bridge Materials - Reinforcing Steel window. 
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Click OK to save the steel material and close the window. 

 

Beam Shapes – Steel I Shape 

To enter a steel shape to be used in the bridge, expand the Beam Shapes, Steel Shapes nodes in the BWS tree and 

select I Shapes. Click on New from the Manage group of the WORKSPACE ribbon (or right click and select New, 

or double click) to open the Steel I Shape window as shown below. 
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Click on the Copy from library… button. Select the W12x40 (Year 2011) from the library. Similarly add another 

Steel I shape, W12x53 (Year 2011) from the library. See images below. 
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Beam Shapes – Steel Angles 

Similar to adding steel I shapes, add the following angles to be used in the bridge. Expand the Beam Shapes, Steel 

Shapes nodes in the BWS tree and select Angles. Click on New from the Manage group of the WORKSPACE 

ribbon (or right click and select New, or double click) to open the Steel Angle window as shown below. Use the 

Copy from library… button and add the L 5x5x0.5 angle.  

  

 

 

Click OK to save the steel angle and close the window. 
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Beam Shapes – Tees 

Similarly, add the following tee shape to be used in the bridge. Expand the Beam Shapes, Steel Shapes nodes in the 

BWS tree and select Tees. Use the Copy from library… button and add the WT 7x15 (2011) tee shape.  

 

Click OK to add the tee shape and close the window. 

Bridge Appurtenances – Parapet 

To enter appurtenances to be used within the bridge, expand the node labeled Appurtenances. To define a parapet, 

double click on Parapet in the BWS tree (or right click and select New or select New from the WORKSPACE 

ribbon). The following window appears. Enter parapet dimensions as shown. 
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Click OK to save the parapet and close the window. 

 

Connectors – Bolt Definitions 

To enter a bolt definition, expand the Connectors node and select Bolt. Click New from the WORKSPACE ribbon 

(or right click and select New, or double click) to open the Structure Definition Connectors – Bolt window. Enter 

the details for a 7/8” diameter high strength bolts as shown below and click the Compute from library… button. 

Note: Select ASTM F3125 Grade A325 from the Library designation menu. 

  

Click OK to save the bolt definition and close the window. 
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Diaphragm Definitions 

Navigate back to the Bridge tab of the Bridge Workspace tree. Double click on the Diaphragm Definitions node 

(or click New from the WORKSPACE ribbon, or right click and select New) to add a new diaphragm definition 

with the input as shown below. 

 

 

Click OK to save the diaphragm definition and close the window. 



3DFEM4 – Curved Steel Multi-Span 3D Example 

Last Modified: 1/17/2024  15 

Steel bridges may contain any of the 4 types of diaphragm definitions.  Straight concrete bridges may only contain 

Type 4 diaphragm definitions. Similarly add 2 more diaphragm definitions – DIA A and DIA B as shown below. 

 

 

Click OK to save the diaphragm definition and close the window. 
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Click OK to save the diaphragm definition and close the window. 
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Lateral Bracing Definitions 

To add a lateral bracing definition, double click on the Lateral Bracing Definitions node in the BWS tree. Enter 

data as shown below. 

 

 

 

Click OK to apply the data and close the window. 
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The default LRFD dynamic load allowance and default LRFD factors will be used.  

 

SUPERSTRUCTURE DEFINITIONS 

Double click on SUPERSTRUCTURE DEFINITIONS (or select SUPERSTRUCTURE DEFINITIONS and 

select New from the WORKSPACE ribbon, or right click and select New) to create a new superstructure definition. 

 

 

Select Girder system superstructure and the Girder System Superstructure Definition window appears. Enter 

the data as shown below. 
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The Design speed and Superelevation are used to compute the centrifugal force effects on the truck live load.  The 

high side of the roadway is assumed to be at the outside of the curve.  

 

 

 

 

 

 

 

 

 

 

 



3DFEM4 – Curved Steel Multi-Span 3D Example 

Last Modified: 1/17/2024  20 

The following types of horizontal alignments are supported. 

 

The Distance from PC to first support line and Distance from last support line to PT are necessary to determine 

the member lengths when the first or last support line is skewed. 

 

If the member starts before the defined PC location, that portion of the member is assumed to be tangent to the curve 

at the defined PC location.  

 

If the member ends after the defined PT location, that portion of the member is assumed to be tangent to the curve at 

the defined PT location.  
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Navigate to the Analysis tab of this window. This tab contains the following settings to control the 3D analysis. 

Enter the information as shown below. 
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Navigate to the Specs tab of this window. The analysis of all member alternatives in the superstructure definition 

will use the following engine and specification set this tab.  An exception to this is LFR rating of curved systems.  

The LFR rating is performed in accordance with the “AASHTO Guide Specifications for Horizontally Curved Steel 

Girder Highway Bridges 2003”. Note: ASR is not available for horizontally curved girders. 

 

Click OK to apply the data and close the window. 
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Load Case Description 

Double click on Load Case Description node in the Bridge Workspace tree and enter the following load cases. 

 

Click OK to apply the data and close the window. 

 

Bridge Alternatives 

Double click on the Bridge Alternatives node in the BWS tree. Enter the data as shown below. 

 

Click OK to apply the data and close the window. 
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Expand the newly added bridge alternative – AS BUILT and double click on SUPERSTRUCTURES node in the 

tree. Enter data as shown below. 

 

Click OK to apply the data and close the window. 

 

Expand the newly added superstructure definition, double click on SUPERSTRUCTURE ALTENRATIVES. 

Enter the data as shown below. 

 

Click OK to apply the data and close the window. 
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The partially expanded BWS tree is shown below. 
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Framing Plan Detail 

Navigate back to the Superstructure definition – AS BUILT CURVED. Expand this node, and double click on the 

Framing Plan Detail node to open the Structure Framing Plan Details window. The Layout tab of this window 

shows how the girders are located in the structure typical section. The following options are available for curved 

girder systems to locate the leftmost girder relative to the superstructure definition reference line.  Enter a negative 

value if the leftmost girder is to the left of the superstructure definition reference line.  This along with the entered 

girder spacing determines the computed radii of the girders. 

 

 

Bearings are oriented in a local coordinate system at each member support in curved girder systems.  The user may 

enter default values for the orientation of the member support constraints on this window and then apply them to all 

members.  This is a shortcut feature to allow for ease of data entry.  The constraints can be modified on the member 

Support window as necessary.  The constraint settings on this window are not used in the analysis, the constraint 

settings on the member Support window are used instead.  

 

Select Tangent if the local x axis for bearing alignment is parallel to the tangent of the member reference line at the 

support. Select Chord if the local x axis for the bearing alignment is parallel to a specified chord angle from the 

tangent of the member reference line at the support.  The following sketch shows an example of defining a bearing 

alignment along a chord. 
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Navigate to the Diaphragms tab of this window to see how diaphragm definitions are assigned to the framing plan.  

The weight of the diaphragms will be computed by the software and applied to the 3D model. 

Diaphragms in curved girder systems can be located by one of 3 methods: 

• entering the spacing along both girders of the bay 

• entering the spacing along the left girder of the bay 

• entering the spacing along the right girder of the bay 

 

The spacing reference type Both must be used when the diaphragms are not radial to either girder.  This spacing 

reference type may also be used when the diaphragms are radial as shown in this example.   

If the diaphragms are located by entering the spacing along the left or right girder of the bay, the resulting 

diaphragm location on the alternate girder will be computed by the program by casting a line perpendicular to the 

tangent of the specified girder at each spacing interval.   
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Enter the following data for each girder bay. These values can be copied from the provided spreadsheet with this 

tutorial to save time. To copy from spreadsheet, follow these steps: 

1. Open the given 3DFEM4-Diaphragms.xslx file in Microsoft Excel. Data for each bay is provided in 

separate sheets named after the bay numbers. For bay 1, navigate to sheet Bay 1. 

2. Use the keyboard shortcut Ctrl+A to select all cells and use Ctrl+C to copy to the clipboard. 

3. Navigate back to BrDR -> Structure Framing Plan Details window -> Diaphragms tab -> Girder bay 

1. Use Ctrl+V to paste the clipboard items in this window. Repeat the process for each girder bay. 

Each girder bay with completed data entry is shown below. 

Bay 1 
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Bay 2 
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Bay 3 
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Bay 4 

 

 

Click Apply to apply the diaphragm definition and keep the window open. 

A wizard is also available to create the diaphragm locations for the user. 
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Navigate to the Lateral bracing ranges tab of this window to see how lateral bracing definitions are assigned to the 

framing plan. Values can be copied from the provided spreadsheet for girder bay 1 and girder bay 4. See images 

below. 

 

 

Click OK to apply the data and close the window. 
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Bracing Spec Check Selection 

Double click on the Bracing spec check selection node in the BWS tree. This window is used to identify which 

diaphragms should be loaded for live load (for both straight and curved girder systems). This window contains a 

listing of each diaphragm location in the superstructure definition.  The first number is the bay number, and the 

second number is the numerical id of the diaphragm starting with 1 for the diaphragm at the start of the bay.  

Selecting a diaphragm in this window will result in influence surfaces for the diaphragm members being generated 

and then loaded with the live load.  BrDR will also perform a specification check on each checked diaphragm. 

Including more diaphragms for specification checking in a 3D analysis can greatly affect the run time and amount of 

memory needed for the analysis.  Note that the diaphragms are always included in the FE model.  This checkbox 

only controls if the diaphragm members are loaded for live load and specification checking. 
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Similarly, the same can be done with the lateral bracing in the Lateral bracing tab of this window as shown below. 

 

Click OK to apply the data and close the window. 
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Structure Typical Section 

Double click on the Structure Typical Section node in the BWS tree to open the Structure Typical Section 

window. This window contains the following options for curved girder systems. The width of the deck must be 

constant along the length of the structure. The overhangs are computed based on the distance from the superstructure 

definition reference line to the leftmost girder and girder spacing entered on the Framing Plan Detail window and 

the deck width entered here. 
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Navigate to the Deck (Cont’d) tab of this window and enter the information related to the deck concrete and 

thickness as shown below. 

 

 

Switch to the Parapets tab and enter the following parapet information. 
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Navigate to the Lane position tab of this window. Use the Compute button to have BrDR compute the lane 

positions. These lane positions are used to compute the LRFD live load distribution factors. 

  

 

Click OK to apply the data and close the window. 

The next step is to add transverse and bearing stiffeners. 

 



3DFEM4 – Curved Steel Multi-Span 3D Example 

Last Modified: 1/17/2024  38 

Transverse Stiffeners 

To add transverse stiffeners, expand the Stiffener Definitions node in the BWS tree. Click on Transverse and 

select New from the WORKSPACE ribbon (or right click and select New, or double click) as shown below. 

 

Select Trans. Plate Stiffener from the Stiffener Type menu. 
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Click OK to apply the data and close the window. 

 

Similarly add another stiffener definition as shown below. 

 

Click OK to apply the data and close the window. 
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Bearing Stiffener 

To add bearing stiffeners, expand the Stiffener Definitions node in the BWS tree. Click on the Bearing node and 

select New from the WORKSPACE ribbon (or right click and select New, or double click) as shown below. 

 

 

Select Plate Stiffener from the Stiffener Type menu. 
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Click OK to apply the data and close the window. 

 

Similarly add another stiffener definition as shown below. 

 

Click OK to apply the data and close the window. 
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Member 

Expand the Members node in the BWS tree and double click on G1 to open the Member window. This window 

shows the data that was generated when the structure definition was created.  No changes are required in this 

window. The first Member Alternative created will automatically be assigned as the Existing and Current Member 

alternative for this Member. 

 

Click Cancel to close the window. 
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Supports 

Expand the G1 node and double click on Supports to open the Supports window for member G1 to see how 

bearings can be oriented for curved girder systems.  For curved girder systems bearings are oriented in a local 

coordinate system at each member support.  Select Tangent if the local x axis for the bearing alignment is parallel to 

the tangent of the member reference line at the support. Select Chord if the local x axis for the bearing alignment is 

parallel to a specified chord angle from the tangent of the member reference line at the support.  

 

 

Click OK to apply the data and close the window. 
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Member Alternative 

Double click on the Member Alternatives node for member G1 in the BWS tree to create a new alternative. The 

New Member Alternative window shown below will open. Select Steel Material type and Plate for Girder type 

and click OK. 

 

 

 

Click Apply the save the data and not close the window.  
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Navigate to the Factors tab. The condition and system factors can be updated on this tab if an inspection report is 

available, and the user can check specific control options from the Control options tab in this window. Make sure to 

uncheck the checkbox – Must consider user input lateral bending stress checkbox under LRFD and LRFR. Enter 

the data as shown below. 
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Click OK to apply the data and close the window. 
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Girder Profile 

Expand the newly added member alternative node and double click on the Girder Profile node. Enter the following 

data in each of its tabs. Since top and bottom flange are the same, the Copy feature can be used to save time. 

Web 
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Top flange 

Navigate to the Top flange tab and enter the following data. Once entered click Apply and then click on the Copy 

to bottom flange button to copy the same rows to the Bottom flange tab of this window. 
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Bottom flange 

 

Click OK to apply the data and close the window. 
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Splice Locations 

Define splice locations for GIRDER 1E by double clicking on the Splice Locations node in the BWS tree. This 

opens the New Splice Location window. Define splice locations as shown below. The splices are the same for all 

locations and all girders. 

 

 

Click OK to open the Splice Location window. Enter details as shown below and click Apply location. Also enter 

details in each tab as shown below.  
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Add the following splice locations in similar manner. 

 

Splice 2 
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Splice 3 
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Splice 4 
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Splice 5 
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Splice 6 
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The added splice locations are shown below. 
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Deck Profile 

Double click on the Deck Profile node in the BWS tree and enter the data describing the structural properties of the 

deck. Clicking on the Compute from typical section… button computes the effective flange widths populate 

automatically. For this example, enter the details as shown below. The Structural thickness has ¼’ deducted from 

the Total deck thickness (as entered in the Structure Typical Section window -> Deck (cont’d) tab) to account for 

an integral wearing surface.  

 

 

The reinforcement is defined on the Reinforcement tab of this window. Enter data as shown below. 
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The Shear connectors tab of this window indicates if the bridge is composite. Enter the data as shown below. 

 

Click OK to apply the data and close the window. 

 

Haunch Profile 

Double click on the Haunch Profile node from the BWS tree. The length can be found in the Member window. 

Enter the data as shown below. 

 

Click OK to apply the data and close the window. 
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Lateral Support 

Double click on the Lateral Support node in the BWS tree to open the window. Enter the data as shown below. 

 

Click OK to apply the data and close the window. 
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Stiffener Ranges 

Double click on the Stiffener Ranges node in the BWS to open the window shown below. Click on the Apply at 

diaphragms… button. 

 

 

Make the following selections and click OK to apply the data and close the window. 
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Click OK to apply the data and close the window. 

 

Bearing Stiffener Locations 

Expand the Bearing Stiffener Locations node and double click on Support 1 as shown below. 
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The bearing stiffeners are defined by selecting the stiffener at each support from the drop down menu. See images 

below for bearing stiffener locations at each support. 
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Schematic – Splice Location 

With Splice Location Span 1 – 109.448000 selected in the BWS tree, click on the Schematic button from the 

WORKSPACE ribbon (or right click and select Schematic) to view the splice schematic as shown below. 
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The description for Girder 1 for this superstructure definition is complete. Girder 2 through Girder 5 are similar. 

The information is provided below. The girder flanges and web sizes are the same as Girder 1. The length will need 

to be updated  for the haunches and lateral support. The stiffeners will need to be generated at the diaphragm 

locations. 
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The following are all of the steps needed to define members alternatives for members G2 through G5. 

Member G2 

 

 Copy and Paster Member Alternative 

An easier/quicker way to enter these member alternatives is to copy the member alternative entered for member G1 

and make changes to selected windows for each member alternative based on the bridge details given.  

To copy, first select the GIRDER 1E member alternative for member G1 and click on the Copy button from the 

WORKSPACE ribbon, or right click and select Copy as shown below. 
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Now, select the node MEMBER ALTERNATIVES under member G2 and click the Paste button from the 

WORKSPACE ribbon or right click and select Paste as shown below. 

 

 

The following warning message shows up indicating that the span lengths are different. Click Yes to continue. 

 

 

 

 



3DFEM4 – Curved Steel Multi-Span 3D Example 

Last Modified: 1/17/2024  74 

The copied member alternative is shown below. Rename the copied member alternative as shown below. 

Double click on the newly copied member alternative for member G2 to open the Member Alternative 

Description window and rename it as shown below. Also uncheck the Must consider user input lateral bending 

stress checkbox in the Control options tab as shown for member G1. 
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Now visit the following windows for this member alternative and make the necessary changes as shown below. 

 

Girder Profile – Web 

 

Girder Profile – Top flange 
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Girder Profile – Bottom flange 
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Splice Location 1 

 

Splice Location 2 
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Splice Location 3 

 

 

Splice Location 4 
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Splice Location 5 

 

Splice Location 6 
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Deck Profile – Deck concrete 

 

 

Deck Profile – Reinforcement 
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Deck Profile – Shear connectors 

 

Haunch Profile 
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Lateral Support 

 

Stiffener Ranges 
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Member G3 

Supports 

 

Member Alternative Description 

Use the Copy and Paste method discussed in the last section to copy member alternative from member G1 to G3. 

Rename the member alternative for member G3 as shown below. 
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Now visit the following windows for this member alternative and make the necessary changes as shown below 

similar to the changes made for G2. 

 

Girder Profile – Web 

 

Girder Profile – Top flange 
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Girder Profile – Bottom flange 

 

 

Splice Location 1 
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Splice Location 2 

 

Splice Location 3 
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Splice Location 4 

 

Splice Location 5 
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Splice Location 6 

 

Deck Profile – Deck concrete 
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Deck Profile – Reinforcement 

 

Deck Profile – Shear connectors 
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Haunch Profile 

 

Lateral Support 
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Stiffener Ranges 

 

Member G4 

Supports 
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Member Alternative Description 

Use the Copy and Paste method discussed in the last section to copy member alternative from member G1 to G4 and 

rename it as shown below. Also uncheck the Must consider user input lateral bending stress checkbox in 

Control options tab as shown for member G1. 

 

 

Now visit the following windows for this member alternative and make the necessary changes as shown below 

similar to the changes made for G2. 

 

Girder Profile – Web 
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Girder Profile – Top flange 
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Girder Profile – Bottom flange 

 

 

Splice Location 1 
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Splice Location 2 

 

Splice Location 3 
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Splice Location 4 

 

Splice Location 5 
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Splice Location 6 

 

 

Deck Profile – Deck concrete 
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Deck Profile – Reinforcement 

 

 

Deck Profile – Shear connectors 
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Haunch Profile 

 

Lateral Support 
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Stiffener Ranges 
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Member G5 

Supports 

 

Member Alternative Description 

Use the Copy and Paste method discussed in the last section to copy member alternative from member G1 to G5 

rename it as shown below. Also uncheck the Must consider user input lateral bending stress checkbox in 

Control options tab as shown for member G1. 
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Now visit the following windows for this member alternative and make the necessary changes as shown below 

similar to the changes made for G2. 

 

Girder Profile – Web 

 

Girder Profile – Top flange 

 

 



3DFEM4 – Curved Steel Multi-Span 3D Example 

Last Modified: 1/17/2024  103 

Girder Profile – Bottom flange 

 

 

Splice Location 1 
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Splice Location 2 

 

Splice Location 3 
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Splice Location 4 

 

Splice Location 5 
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Splice Location 6 

 

Deck Profile – Deck concrete 
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Deck Profile – Reinforcement 

 

Deck Profile – Shear connectors 
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Haunch Profile 

 

Lateral Support 
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Stiffener Ranges 
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3D Analysis Settings 

It is not recommended that users launch an analysis in training due to the large number of degrees of 

freedom in this example. The analysis runtime will require a 64 bit PC and adequate memory that is likely 

not available on attendee laptops. 

LRFD Design Review 

To perform a 3D LRFD  design review on the superstructure, from the Analysis group of the DESIGN/RATE 

ribbon, click on the Analysis Settings button to open the window shown below. Apply the following selections for 

an HL93 Design review. 
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Navigate to the Output tab of this window and apply the following settings. Make sure to check the Detailed 

influence line loading checkbox to view the centrifugal force calculations. 

 

Click OK to apply the settings and close the window. 

 

With the AS-BUILT CURVED superstructure definition selected on the BWS tree, click the Analysis button from 

the Analysis group of the DESIGN/RATE ribbon. 
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Specification Check Detail - LRFD Design Review 

Select the member alternative GIRDER 1E of member G1 and click on the Specification Check Detail button 

from the Results group of the DESIGN/RATE ribbon to view all the spec check articles for this alternative. 
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LFR Rating 

In the Analysis Settings window select the following vehicles and settings for an LFR rating. 

 

The example in the AASHTO Guide Specification is for an HS25 loading.  To produce this loading, enter a scale 

factor of 1.25 in the Vehicle Properties window as shown below. 
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Navigate to the Output tab and check the checkboxes shown below to generate detailed reports. Be sure to check 

the Detailed influence line loading to be able to view the centrifugal force calculations. 

 

This example shows the results from a 3D LFD rating.  It is not recommended that users launch an analysis 

in training due to the large number of degrees of freedom in this example The analysis runtime will require a 

64 bit PC and adequate memory that is likely not available on attendee laptops. 

 

The software develops the 3D model using the member alternative marked as Existing for each member.  If the 

member does not have a member alternative marked as Existing and only has 1 member alternative, that member 

alternative is used for the 3D model.  If the member has no member alternative marked as Existing and more than 1 

member alternative, the analysis will not be performed. 
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When the analysis is launched for the superstructure definition, spec checking and rating is only performed for the 

member alternatives marked as Existing.  When the analysis is launched for a single member alternative (as shown 

below), the spec checking and rating will only be performed for that member alternative. 

 

A feature for both straight and curved girder system FE analysis is the ability to reuse existing FEA results.  The 

program will generate new dead load and live load influence surface FE models and compare the models to previous 

models.  If the models compare exactly then the FEA results will be reused.  The live load will be applied to the 

previous influence surfaces.  This leads to a greatly reduced runtime on successive runs.   

 

Engine Outputs – LFR Rating 

Select the GIRDER 1E member alternative for member G1 and click the Engine Outputs button on the Results 

group of the DESIGN/RATE ribbon. The following shows the output files created by the 3D LFR rating.   
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The 3D Model files list the data for the models including nodes, members, properties, and loads.  The 3D Model 

Actions files list the FE results (reactions, element actions, displacements) for the models.  The Model Graphics 

files can be opened to graphically view the FE models.  The following shows the graphics for the Stage 1 model 

which contains the steel beams and diaphragms. 
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Node and element numbers can be turned on from the Tools menu.  The mouse controls manipulation of the view.  

Zoom by rolling the mouse wheel.  Translate by pushing down the mouse wheel. Rotate by pushing down the left 

mouse button. 

The generated influence surfaces for the unit live loading can be viewed by selecting the Stage 3 Graphics model 

and then selecting File -> Open -> Influence Surfaces.sur.  This opens the Influence Surface window as shown 

below. An influence surface for viewing can be chosen by selecting Tools -> Change Influence Surface and then 

selecting desired actions. 
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Tabular Results – LFR Rating 

From the Results group of the DESIGN/RATE ribbon, click on Tabular Results to view the LFR rating results for 

member alternative GIRDER 1E as shown below. 
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Specification Check Detail – LFR Rating 

From the Results group of the DESIGN/RATE ribbon, click on Specification Check Detail to view the LFR spec 

check results for member alternative GIRDER 1E as shown below. 
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LFR Rating from Bridge Explorer 

Rating of a bridge can be performed from the Bridge Explorer as well. To do this, first the newly created bridge 

description needs to be saved. Click on the Save button from the WORKSPACE ribbon to save the bridge to the 

database.  

 

 

Now from the Bridge Explorer, select the bridge, and click on the Rate button from the RATE ribbon (or right 

click and select Rate) as shown below. 
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This opens the Analysis Settings window. Apply the same settings as discussed in the LFR analysis section of this 

tutorial and click OK to initiate the rating process. This opens the Analysis Progress window listing details of the 

ongoing analysis. Once the analysis is complete, review this window for any warnings, or error messages and click 

OK to close the window. 

 

 

Clicking OK on the window shown above closes the Analysis Progress window and opens the Bridge Rating 

Results window. Alternatively, this window can be opened by clicking on the Rating Results button from the 

Results group of the RATE ribbon or right clicking and selecting Rating Results 
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The 3D LFR results of the HS25 ratings are shown for all girders when run using the bridge explorer. Click on the 

View structure rating results button in this window to view the results per structure in the Structure Rating Results 

window. In this window, click on the View member rating results button to view rating factors per member. (See 

images below). 
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The centrifugal force effect calculations can be found in the detailed influence surface loading files found in the 

following folder (of the Documents folder). 
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3D Model  

The modeling techniques used are the result of a survey of researchers and practitioners and review of several 

software packages.  

Steel Members  

The model for a girder system structure with steel girders is comprised of the following:  

• Shell elements for the deck  

• Beam elements for the top and bottom flanges.  

• Shell elements for the web. Web shell elements are divided into equal segments for web shells. The shell 

nodes may be adjusted to match diaphragm connections.  

• For curved structures, curvature is represented by straight elements with small kinks at node points instead 

of curved elements.  

• Master-slave constraints that connect the top flange to middle of deck. The distance ‘A’ as shown in figure 

below is measured from the center of the deck to the center of gravity of the top flange (including cover 

plates) at the start of G1. The same value is used everywhere for all girders to maintain horizontal elements.  

 

Master-Slave

Constraints

Flange (Beam Elements)

Web (Shell Elements)

Flange (Beam Elements)

Deck (Shell Elements)

Section
Partial Elevation View of 

Model

A
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The moment at a beam cross section is calculated by solving the equilibrium equations at that section. This moment 

is then used in the specification check articles in the same way that it would for a line girder analysis. 

Master-Slave

Constraints

Flange (Beam Elements)

Web (Shell Elements)

Flange (Beam Elements)

Deck (Shell Elements)

M

Element

Nodal

Forces

Section
Partial Elevation View of 

Model

A

 

 

Mesh Generation  

The FE model created by BrDR will contain nodes at the following locations.  

• Cross section property change points  

• Span tenth points  

• Support locations  

• Diaphragm locations  

• User defined points of interest  

The user controls the mesh generation by the controls previously shown on the Superstructure Definition: 

Analysis tab. The software creates the mesh following the number of elements selected between beams or within the 

web of a steel beam and the target aspect ratio entered by the user. The presence of nodes at the locations listed 

above may result in some elements falling outside the target aspect ratio.  
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The following plan views show how the mesh for this example can be controlled by the user. 

1 shell between beams, target aspect ratio = 4 

 

 

4 shells between beams, target aspect ratio = 2 
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Loading  

The program computes all the dead loads acting on the beam including the self-weight of the beam, user defined 

appurtenances on the structure typical section, wearing surfaces, diaphragms, and user defined member loads. 

Composite dead loads are applied directly to the deck shells in the 3D model in their actual location. They are not 

distributed to the girders based on the choices available in the Superstructure Loads window as they are for a 2D 

line girder analysis.  

 

 

The Stage 3 FE model is loaded with unit loads at each deck node within the travelway to generate influence 

surfaces for the beam. Lane positions and combinations are determined based on the travelway, and the transverse 

loading parameters set by the user on the Superstructure Definition: Analysis Settings tab. The influence surfaces 

are then loaded with the selected vehicles to find the maximum live load effects. 
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Analysis and Results 

LFR (HS-20 scaled to HS-25) 

 

 

Girder 1E 

 

 

Girder 2E 
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Girder 3E 

 

 

Girder 4E 

 

 

Girder 5E 

 

 



3DFEM4 – Curved Steel Multi-Span 3D Example 

Last Modified: 1/17/2024  130 

LRFR (HL-93) 

Run an LRFR 3D analysis with HL-93 (US) vehicle in Inventory and Operating from the Bridge Explorer. Below 

are the results for this analysis. 
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